


 

Wine Master™ Version 2.0 

Copyright © 2002 by Poohbah Industries 

Disclaimer 
Poohbah Industries makes no warranty, either expressed or implied, including but not limited to any implied warranties of merchantability of fitness for a 
particular purpose, regarding these materials and makes such materials available solely on an “as-is” basis. 

In no event shall Poohbah Industries be liable to anyone for special, collateral, incidental, or consequential damages in connection with or arising out of 
purchase or use of these materials.  The sole and exclusive liability to Poohbah Industries, regardless of the form of action, shall not exceed the purchase price of 
the materials described herein. 

Poohbah Industries reserves the right to revise and improve its products as it sees fit.  This publication describes the state of this product at the time of its 
publication, and may not reflect the state of the product in the future. 

Poohbah Application Trademarks 
Wine Master is a trademark of Poohbah Industries. 

Software for the Connected Lifestyle is a trademark of Poohbah Industries. 

Third Party Trademarks 
All other brand names, product names, or trademarks belong to their respective owners.  



Table of Contents 

Chapter 1: Introduction ........................................................................................................................... 1 
User Guide Overview ............................................................................................................................................................. 1 
Summary of the Chapters .................................................................................................................................................... 1 

Program Overview .................................................................................................................................................................. 1 
Data Organization .................................................................................................................................................................. 1 

Features .................................................................................................................................................................................. 2 

New Features of Version 2.0.............................................................................................................................................. 2 

Poohbah Industries............................................................................................................................................................... 2 

Chapter 2: Installation............................................................................................................................ 3 
Chapter Overview.................................................................................................................................................................. 3 
System Requirements........................................................................................................................................................... 3 
Windows Basics and Wine Master..................................................................................................................................... 3 
Procedures .............................................................................................................................................................................. 4 
Installation ............................................................................................................................................................................. 4 

Registration ............................................................................................................................................................................ 4 

Removing Wine Master......................................................................................................................................................... 5 

Chapter 3: Getting Started ................................................................................................................... 6 
Chapter Overview.................................................................................................................................................................. 6 
Wine Master User Interface ............................................................................................................................................. 6 
Main Screen............................................................................................................................................................................ 6 

Title Bar .................................................................................................................................................................................. 6 

Menu Bar ................................................................................................................................................................................. 7 

Toolbar..................................................................................................................................................................................... 7 

Data Table............................................................................................................................................................................... 8 

Shortcut Menu ....................................................................................................................................................................... 9 

Keyboard Shortcuts ............................................................................................................................................................. 9 

Entering Data ........................................................................................................................................................................10 
Catalog ....................................................................................................................................................................................10 

Categories ..............................................................................................................................................................................10 

Wine Names...........................................................................................................................................................................12 

Vintages ..................................................................................................................................................................................15 

Saving a Collection ...............................................................................................................................................................16 

Files .........................................................................................................................................................................................17 
Help .........................................................................................................................................................................................17 

  i



Chapter 4: Advanced Features.............................................................................................................19 
Chapter Overview.................................................................................................................................................................19 
Importing and Exporting ....................................................................................................................................................19 
Procedures .............................................................................................................................................................................19 

Sample Files..........................................................................................................................................................................20 
Finding Wine Names ............................................................................................................................................................21 
Sorting the Collection ........................................................................................................................................................22 
Upgrading Wine Master.....................................................................................................................................................22 
HotSync.................................................................................................................................................................................23 
Printing...................................................................................................................................................................................27 

Chapter 5: Appendices ..........................................................................................................................28 
Commands..............................................................................................................................................................................28 
Table Columns........................................................................................................................................................................31 

Chapter 6: Glossary ...............................................................................................................................32 

  ii



 

Chapter 1: Introduction 

User Guide Overview 
This user guide will get you up and running with Wine Master in a few minutes.  Chapters 1–3 cover 
the basics.  Refer to the rest of the guide for more details about particular operations. 

Summary of the Chapters 
� Chapter 1: Introduction gives an overview of the program. 
� Chapter 2: Installation guides you through the installation and registration of the program. 
� Chapter 3: Getting Started covers data entry and data management. 
� Chapter 4: Advanced Features introduces you to additional methods, beyond the basics.  

Refer to this chapter after Wine Master is running. 
� Chapter 5: Appendices explains, in tables, the commands used in Wine Master and the data 

table fields. 
� Chapter 6: Glossary lists the terminology used in the guide. 

Program Overview 
Wine Master Version 2.0 is a versatile application for managing wine collections.  It is ideal for storing 
information (vintages, holds, prices, bins, and notes).  Its easy and intuitive interface makes it a 
welcome utility for anyone acquainted with Microsoft Windows™.   

Data Organization 
Wine Master stores information about your collection in three levels: 
� Categories 
� Wine Names 
� Vintages 

A category is a grouping of wines by a common characteristic.  The category is the highest level in 
the database hierarchy—every wine belongs to a category.  The list of categories is called the 
catalog. 
The second level is the wine name, often called the name.  Wine names are sub-groups of categories 
and grouping units for vintages. 
The third level is the vintage.  Vintages, the sub-groups of the wine names, are the basic unit of the 
collection. 
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Features 
Wine Master provides the following features: 
� User Defined Categories: Wines can be categorized as you wish.  Here are some examples of 

categories: White Wines, Red Wines, Dessert Wines, Favorites, To Hold, To Buy, and Gifts.  
� Import and Export Files: Wine Master can merge data from different file types and convert data 

into different file types. 

Note: Over 11,000 wine reviews are available, free for registered Wine Master users, on the 
Poohbah web site (http://www.poohbah.com) for downloading and importing. 

� HotSync®: Palm handheld device owners can manage one wine collection simultaneously on 
their handheld and on their desktop with easy file synchronization.  

New Features of Version 2.0 
� Perform HotSync operations with Wine Master for Palm 2.1 or later 
� Ample space to enter long, descriptive Wine Names 
� Bin field in Vintages table for storing cellar location 
� More columns added to Vintage view 
� Expanded Help 

Poohbah Industries 
Wine Master is a Poohbah Industries product.  To learn about the other products developed by 
Poohbah Industries, visit: www.poohbah.com 
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Chapter 2: Installation 

Chapter Overview 
Installation covers the procedures for installing, registering, and removing Wine Master. 

System Requirements 
� IBM® (or compatible) PC® 486 or above  
� Microsoft® Windows® 95, 98, NT®, 2000, ME®, or XP® operating system 
� 3 MB free disk space 
� VGA monitor that supports 16 colors or more 
� Mouse 

Windows Basics and Wine Master 
To use Wine Master, you should be familiar with basic Windows-based concepts; such as click, right-
click, double-click, and menus.  To do almost everything in Wine Master, you must use commands.  
Choose commands in Wine Master in three ways: 
� Menus:  Select a command from a primary menu or a floating, short-cut menu. 
� Keyboard shortcuts:  Choose a command by typing a key combination. 

Note: Key combinations for shortcuts are listed by their corresponding commands in the 
menus. 

� Toolbar:  Click an icon on the toolbar. 
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Procedures 

Installation 

Installing the Wine Master  
You can install Wine Master by downloading from our website.  Download the software as follows: 

1. Visit our website at: www.poohbah.com  
2. Click the hyperlink to Wine Master for Windows Download.  The Poohbah Industries 

Download page appears. 
3. Click the hyperlink to Desktop End User License Agreement to read and accept the agreement 

conditions. 
4. Click the hyperlink to Windows Self Expanding.  The File Download wizard appears. 

The wizard enables you to choose where to download the software to and what to do after 
completion.  You can also choose all the default settings. 
Downloading progress is shown on a gauge. 

5. Clear the checkbox for closing the dialog box after download is complete. 
After downloading, click Open. 

6. Specify the folder in which to install Wine Master.  The default folder is C:\Program 
Files\Poohbah\Wine Master for Windows.  To change the folder, click Browse and select the 
path and folder of your choice. 

7. Click OK in the Wine Master for Windows dialog box. 
Setup is preparing the InstallShield Wizard; this takes a few minutes. 

8. Follow the InstallShield Wizard instructions as they appear. 

Registration 
Registering Wine Master entitles you to the following benefits: 
� Unlimited item storage 
� Free updates 
� Customer support (via email) 

Installation  4

http://www.poohbah.com/


Registering Wine Master 
To register Wine Master, you must run the program.   
Note Obtain a registration number from our website (www.poohbah.com). 

1. Start the Wine Master program. 
2. From the Options menu, select Register to open the Registration dialog box. 
3. Type in your name and registration number in the appropriate boxes of the Registration screen.  

Click OK to close the dialog box. 

 

Removing Wine Master 
Note If the Wine Master conduit is installed, remove it before removing Wine Master.  See 

Removing the Wine Master Conduit on page 26. 
Remove Wine Master from Windows as follows: 

1. Exit the program after making sure that the Wine Master conduit is not installed. 
2. From the Windows Start menu, select Settings | Control Panel. 
3. Select Add / Remove Programs. 
4. Select Wine Master from the program list and click Add / Remove. 
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Chapter 3: Getting Started 

Chapter Overview 
Getting Started covers the essentials of managing your collection with Wine Master: 

� Wine Master User Interface 
� Entering Data 
� Files 

After installing Wine Master, double-click the Wine Master icon  on the Windows Desktop to launch 
the program.  The Wine Master main screen appears. 

Wine Master User Interface 

Main Screen 
The main screen is shown below with its five elements. 

 

Title Bar
Menu Bar

Toolbar

Data Table

Status Bar

Title Bar 
The title bar shows the file name and the program name.  Untitled is the file name when the program 
opens and after you select the New command. 
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Menu Bar 
The menu bar contains five menus.  You can access all of the Wine Master commands through the 
menu bar.  The menus are: 
� File: File related and print related commands 
� Options: Register and HotSync commands 
� View: View selection commands 
� Wine: Wine collection commands 
� Help: Help and About commands 

For a detailed description of the menu commands, see 
� Appendix A: Data Commands, page 28 
� Appendix B: Additional Commands, page 29 

 

Toolbar 
Access ten common commands with the toolbar.  The commands accessed by the toolbar are: 
� New: Create a new file 
� Open: Open an existing file 
� Save: Save the file 
� Add: Add a new wine name or vintage 
� Delete: Delete a selected wine name or vintage 
� Duplicate: Copy a selected wine name or vintage 
� Edit: Edit a selected wine name or vintage 
� Print: Print the currently viewed data 
� About: Display program information 
� Help: Open the help file 

For a detailed description of the menu commands, see 
� Appendix A: Data Commands, page 28 
� Appendix B: Additional Commands, page 29 

 

Getting Started  7



Data Table 

Data Table Features 
Wine Master shows collection data on a table in the main screen.  The information that appears 
depends on which view is selected.  The following features enable easy viewing of the information: 
� Sorting by Columns: Sort the rows in alphanumeric order by clicking a column header. 

Clicking a column header does not permanently rearrange the records in the grid. 
� Adjusting Column Width: Adjust the width by dragging the border between columns to the 

desired width. 
� Locating Records:  Wines and categories are easily located by typing the first letter in the 

name after clicking one of the lines in the grid. 

Viewing Data 
The main screen table displays collection data in three views: 
� Catalog:  A list of wine categories defined by the user.  All wines must belong to a category.  

Examples of categories are: red, white, and dessert. 

 

� Name:  A list of wine names.  Every wine must belong to a category and have a name.  An 
example of a name is HR Pinot Noir. 

 

� Vintage:  A list of vintages, the year the grape was picked. 

 

For a detailed description of the views and their columns, see Appendix C: Table Columns, page 
31. 
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Changing a View  
In order to move from one level of detail to another,  change the view of the table.  Changing the view 
is done with menu commands: 

1. Right-click in the data table to open the view menu. 
The current view appears in the menu with a check to its left. 

 
2. Select the desired view. 

Viewing Wines and Vintages by Category 
While viewing the wines and vintages, you can sort the records by category.  This enables you to 
view the details of a category. 

1. While in View by Name or View by Vintage, click the Category column header to sort the list, 
alphabetically, by category. 

2. Scroll in the list to the records belonging to the desired category. 

Shortcut Menu 
A standard Windows feature that you may want to use is the shortcut menu.  The shortcut menu is a 
floating menu that appears when you right-click the data table, text boxes, and dialog boxes.  The 
commands in the shortcut menu are specifically relevant to the selected item. 

Keyboard Shortcuts 
Keyboard shortcuts are keystrokes that activate a command directly.  This is a convenient way of 
activating a command when your hands are on the keyboard. 
To activate a menu-item command using a keyboard shortcut, press simultaneously the Alt key and 
the letter underlined in the menu-item title. 
See a list of command shortcuts in Appendix B: Additional Commands, page 29 
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Entering Data 
The data in Wine Master is a collection of wines organized as follows: 
� Catalog 
� Categories 
� Wine names (called names) 
� Vintages 

The vintages are the basic unit of the collection.  Every vintage belongs to a wine name and every 
wine name belongs to a category.  The group of categories is called the catalog. 

Catalog 
The catalog is a list of categories.  When the data table is in the Catalog view, the rows shown are: 
the categories, a summary row (All), and a row for uncategorized wines (Unfiled). 

Categories 
A category is a grouping of wines by some common characteristic.  Each collection can have up to 15 
categories, plus the Unfiled category. 
Typical category names are: 
� Chardonnay  
� Red 
� White 
� Sparkling 

Categories can also be named: 
� Favorites 
� To Buy 
� To Hold 
� Gifts 

Note Category names can be any alphanumeric text of up to 15 characters.  So, long 
category names need to be shortened.  Cabernet Sauvignon, for example, could be entered as 
Cabernet Sauvig. 
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Adding a Category 
Add a category as follows: 

1. From the Wines menu, select Categories to open the Edit Categories dialog box. 

 
2. Select New to open the New Item dialog box. 
3. Type a new category name in the text box and click OK to close the New Item dialog box. 

 
4. Click OK to exit the Edit Categories dialog box. 

Deleting a Category 
Before deleting a category, check if there are wine names that belong to it.  If there are any wine 
names and vintages that belong to the category, Wine Master categorizes them as Unfiled after the 
category is deleted. 
To see how to check which wines belong to a category see Viewing Wines and Vintages by 
Category, page 9. 
1. From the Wines menu, select Categories to open the Edit Categories dialog box. 
2. Select a category name and click Delete.  A Delete Item confirmation box appears. 
3. Click OK to confirm and close the confirmation box. 
4. Click OK to exit the Edit Categories dialog box. 

Renaming a Category 
1. From the Wines menu, select Categories to open the Edit Categories dialog box. 
2. Click a category name and click Rename. 
3. Type the revised category name in the text box and click OK. 
4. Click OK to exit the Edit Categories dialog box. 

Getting Started  11



Wine Names 
Wine names are the middle level in the data hierarchy.  They are the sub-groupings of the categories 
and the grouping units of the vintages.  The name given to each wine can have up to 71 
alphanumeric characters. 

Adding a Wine Name 
Add a wine name as follows:  

1. Select View by Name. 
To learn how to select a view, refer to Changing a View, page 9. 

2. Click  to open the Wine dialog box. 
3. Type in the wine name in the text box and select the category from the drop-down list. 

To add vintages from the Vintage List Panel see Managing Vintages from the Wine Dialog 
Box, page 16. 

4. Click OK to exit the Wine dialog box. 

Adding a Wine Name from an Undefined Category 
Wine names can be added before defining their categories as follows: 

1. Select View by Name. 
To learn how to select a view, refer to Changing a View, page 9. 

2. Click  to open the Wine dialog box. 

 

Categories
Drop-down

List

Wine Textbox

Vintage List
Panel
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3. Type the wine name in the text box and select Edit Categories from the drop-down list.  The 
Edit Categories dialog box appears. 

 
4. Select New to open the New Item dialog box. 
5. Type a new category name in the text box and click OK. 

 
6. Select the new category and click Select to return to the Wine dialog box with the new category 

selected. 

 

 
7. Click OK to exit the Wine dialog box. 
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Deleting a Wine Name 
Delete a wine name as follows: 

1. Select View by Name. 
To learn how to select a view, refer to Changing a View, page 9. 

2. Select a wine and notice how many vintages it has (in the Vtg column) and how many bottles (in 
the Qty column). 

3. Click  to open the Delete Wine confirmation box. 
4. Click OK to exit the confirmation box. 

Duplicating a Wine Name 
Duplicating a wine name is a quick way to add a new wine.  Duplicate copies all of a selected wine’s 
properties (including the name).  After duplicating a wine name, edit the information to fit the new 
addition. 

1. Select View by Name. 
To learn how to select a view, refer to Changing a View, page 9. 

2. Select a wine with similar characteristics: name, category, and vintage list. 
3. Click . 
4. Edit the new wine name (see the next section) to differentiate it from the selected wine name. 

Editing a Wine Name 
Edit a wine name as follows: 

1. Select View by Name. 
To learn how to select a view, refer to Changing a View, page 9. 

2. Double-click the row in the table of the wine name you want to edit.  The Wine dialog box 
appears. 

3. Change the information in the desired field—the Name text box or the Category drop down list. 
4. Click OK to exit the Wine dialog box. 
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Vintages 
The basic unit of the wine collection is the vintage.  A vintage is the yield of a particular vineyard in a 
single season.  Every vintage has distinct qualities and characteristics and Wine Master enables easy 
management of vintage information. 

Adding a Vintage 
Add a vintage as follows: 

1. Select View by Vintage. 
To learn how to select a view, refer to Changing a View, page 9. 

2. Select a wine from the table. 
3. Click  to open the Vintage dialog box. 
4. Type in the vintage information in the appropriate fields. 

 

Name and 
Category 

5. Click OK to exit the Wine Vintage dialog box.   

Deleting a Vintage 
Delete a vintage as follows: 

1. Select View by Vintage. 
To learn how to select a view, refer to Changing a View, page 9. 

2. Select a wine from the table. 
3. Click  to open the Delete Vintage confirmation box. 
4. Click OK. 
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Duplicating a Vintage 
Duplicating is a quick way to add a new vintage.  Duplicate copies all of a selected vintage’s 
properties.  After duplicating, edit the information to fit the new addition. 

1. Select View by Vintage. 
To learn how to select a view, refer to Changing a View, page 9. 

2. Select a vintage from the table to base the new vintage on. 
3. Click  to open the Wine Vintage dialog box.  The fields contain the data copied from the 

selected vintage. 
4. Change the data in the dialog box where applicable and click OK. 

Editing a Vintage 
Edit a vintage as follows: 

1. Select View by Vintage. 
To learn how to select a view, refer to Changing a View, page 9. 

2. Double-click the row in the table of the vintage you want to edit.  The Vintage dialog box 
appears. 

3. Edit the information in the dialog-box fields. 
4. Click OK to exit the Vintage dialog box. 

Managing Vintages from the Wine Dialog Box 
Vintage data can be managed from within the Wine dialog box.  Selecting one of the four buttons—
Add, Delete, Duplicate, or Edit— in the Vintage List panel activates the corresponding command. 

 

Saving a Collection 

To quickly save a collection, click  on the toolbar. 
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Files  
Wine Master stores data in Wine Master for Windows files (*.pwa).  Wine Master can import and 
export files of other types: 
� Comma Separated Values files (*.csv) for exporting to and importing from Excel, other 

spreadsheet programs, and database programs. 
� Wine Master for Palm Databases files (*.pdb) for manual synchronization of files kept on 

desktops and Palm handheld devices. 
� Wine Master Add-In files (also *.pdb) for importing wine reviews, and exporting and merging files 

into other wine collections. 
� Robert Parker text files (*.txt) for adding vintage information from Robert Parker’s Wine 

Advocate software. 
For more information about Robert Parker, see page 32 in the Glossary. 

Help 
Wine Master uses Windows standard user interface, so learning how to use the program is easy.  If 
questions do arise, there are three ways to find the answers: 
� Select Help Topics from the Help menu 
� Click  and drag the mouse to the graphic object in question 
� Write to grand@poohbah.com about your problem
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Chapter 4: Advanced Features 

Chapter Overview 
Its time to learn Wine Master’s advanced features.  The following topics are covered in this chapter: 
� Importing and Exporting 
� Sorting the Collection 
� Finding Wine Names 
� Upgrading Wine Master 
� HotSync 
� Printing 

Importing and Exporting 
Wine Master reads from and writes to Wine Master for Windows files.  Wine Master can also import 
from and export to different file types.  The file types that Wine Master can import and export are: 
� Desktop files: Text files with a .csv (comma separated variable) extension.  Desktop files can be 

exported from Microsoft Excel. 
� Wine Master for Palm Databases files: Files with a .pdb extension.  Wine Master for Palm 

Databases files can be exported from a Palm handheld. 
� Wine Master Add-in files: Wine review files and Wine Master for Palm Databases files.  

Importing Wine Master Add-In files (also with a .pdb extension) enables you to merge records 
selectively. 

� Robert Parker files (Import only): Text files with notes about wines and vintages.  Robert Parker 
files can be downloaded from the Internet. 

Procedures 

Importing a File 
1. From the File menu, select Import. 
2. Select the file type that you want to import.  An Import dialog box appears. 
3. Specify the folder where the file is. 
4. Select the file from the Import dialog box and click Open. 
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Exporting a File 
1. From the File menu, select Export. 
2. Select the file type that you want to export.  A Save As dialog box appears. 
3. Specify a folder and type a filename in the text box. 
4. Click Save. 

Converting a File to Wine Master Add-in Format 
Wine Master Add-in files can be imported selectively.  Other import file types can be imported 
selectively by converting them into Wine Master Add-in files. 
To import selectively from a file that is not a Wine Master Add-in, follow these steps: 

1. Import the file. 
2. Export the file as a Wine Master Add-in. 
3. Import the new Wine Master Add-in file and select which records to merge. 

 

Sample Files 
Three files with sample data come with the installation.  The files include a number of Wine 
Categories, Names, and Vintages.  The sample files are: Sample1.scv, Sample2.scv, and 
Sample3.scv.  Open a sample file by selecting the File | Import | Desktop command. 
To learn how to import a file, see Importing a File, page 19. 
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Finding Wine Names 
Finding a wine in a large collection can present a problem.   The Find command is a useful tool for 
quick navigation within a collection.  It locates all the wines that match a search text that you type in.  
The search text entered does not have to be the first letters in the wine name.  For example, you can 
search for HR Pinot Noir, by using Pinot as your search text. 

Finding a Wine 
1. Type <Ctrl + F> (Find) to show the Find dialog box. 

The Find command can also be called by selecting Find from the Wine menu. 
Note The command Find works in all table views.  In View by Wine, the table displays the 

search result as a highlighted row.  In View a Catalog and View by Vintage, the search 
result is displayed in a Wine dialog box. 

2. Type the search text into the text box. 
A search text can be any consecutive alphanumeric characters appearing in a wine name.  
Longer search texts ensure quicker success. 

 
Click OK.  The first wine matching the search text appears. 

3. Proceed to the Find Next command as follows: 
If the search result is not the right wine then type the keyboard shortcut <Ctrl + G> (Find Next) 
to locate the next match. 

4. Continue Step 3 until the search result is the desired wine. 
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Sorting the Collection 
Every new wine added to the collection appears at the end of the table.  Sorting puts the wine names 
in alphabetical order.  It is not necessary to sort the collection after every wine addition, but it should 
be done when navigation becomes difficult. 
Note Tables can be sorted, on a temporary basis, by clicking the column header in the data 

table. 

Sorting the Wine Collection: 
1. From the Wine menu, select Collection to open the Collection dialog box. 

 
2. Click Sort. 

Upgrading Wine Master 
Registered users can download free upgrades of Wine Master as follows: 

1. From the Poohbah Industries web site (www.poohbah.com) click Download. 
2. If an upgrade is available, select the upgrade option and follow the brief instructions on the 

Download page. 
3. When the download is complete, continue the installation as follows: 

From the folder with the downloaded upgrade file, double-click the file <winemaster.exe>. 
4. The Wine Master Installation dialog box appears—click Yes to complete the installation. 
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HotSync 
If you own a Palm handheld device, you can install Wine Master for Palm and synchronize data 
between your handheld and your desktop.  This operation is called HotSync.  You can insert and edit 
data on either your Palm handheld or your desktop computer and let Wine Master synchronize them 
by performing a HotSync operation. 
Synchronizing data files means comparing and copying missing data from one file to another—one on 
your desktop and one on your handheld.  The Wine Master database on your Palm handheld is 
compared with your Wine Master HotSync collection on the desktop.  Any changes made in one 
collection are copied to the other. 
To set up HotSync, perform the following three procedures: 

1. Installing the Wine Master Conduit (on this page) 
2. Selecting a Collection Used for HotSync (on page 24) 
3. Setting the Desktop/Handheld Override for the First HotSync (on page 25) 

Note Setting the desktop/handheld override is very critical.  Read the procedure instructions on 
page 25 very carefully before your first HotSync. 

Installing the W ne Master Conduit i
1. From the Options menu, select Hot-Sync. 
2. Click Setup from the Conduit panel of the Hot-Sync dialog box. 
3. Click Install from the Hot-Sync Conduit dialog box. 
4. Click OK after seeing the message The Wine Master conduit was successfully installed. 

After the conduit has been installed, proceed to Selecting a Collection for HotSync. 
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Selecting a Collection Used for HotSync  
A wine collection must be selected for synchronizing.  Selecting a collection can be done right after 
installing the Wine Master conduit. 

1. From the Option menu, select Hot-Sync and click Select in the collection panel.  A Select the 
Collection for HotSync dialog box appears. 

2. Select a wine collection file from the dialog box.  Click OK to exit. 
3. Proceed to Setting the Desktop/Handheld Override. 
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Setting the Desktop/Handheld Override 
Note Your first HotSync operation is very critical.  Please read this section before performing 

your first HotSync. 
You must decide whether the collection on your handheld or the collection on your desktop is the 
dominant database for the first HotSync operation.  Otherwise, you may either duplicate records or 
erase records in both collections. 
The two options are: 
� Desktop Overwrites Handheld (the desktop version is the dominant one) or 
� Handheld Overwrites Desktop (the handheld version is the dominant one). 

To set the desktop/handheld override, do the following: 
1. Open the Palm HotSync Manager. 
2. Select Custom from the HotSync Manager menu. 
3. Select Wine Master from the Conduit column of the Custom dialog box, and click OK. 
4. Select Desktop overwrites handheld or Handheld overwrites desktop in the Wine Master dialog 

box, and click OK. 
After the first HotSync operation, both devices keep in synchronization automatically. 
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Removing the Wine Master Conduit 
It is necessary to remove the Wine Master conduit before removing Wine Master from the operating 
system.  Remove the conduit as follows: 

1. From the Options menu, select Hot-Sync.  The Hot-Sync dialog box appears. 

 

2. Click Setup if the top panel reports that the conduit is installed.  The Hot-Sync Conduit dialog 
box appears. 

 

3. Click Uninstall.  A message box reports that the Hot-sync conduit was uninstalled (removed) 
successfully. 
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Printing 
Wine Master prints three reports, one for each of the three views: 
� Catalog 
� Wine Names 
� Vintages 

The reports display what appears in the data table. 

Printing a Report 
1. Select the view of the report you want to print. 

To learn how to select a view, refer to Changing a View, page 9. 
2. Check that all the columns appear in the report by building a print-preview. 

To build a print-preview, select Print Preview from the File menu. 
If the page is not wide enough to show all of the columns, change the page orientation from 
Portrait to Landscape.  Click Close to exit the Print-Preview. 

3. Click  to open the Print dialog box and click OK. 
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Chapter 5: Appendices 

Commands 
Appendix A: Data Commands 

Command Select 
Methods* 

Table View Description 

Catalog 

Names 

Opens the Wine dialog box for adding a new name Add Wine | Add 

 
Vintages Opens the Vintages dialog box for adding a new 

vintage to the selected wine name 

Names Deletes the selected wine name and its vintages Delete Wine | Delete 

 
Vintages Deletes the selected vintage 

Names Adds a new wine name and copies the properties of 
the selected wine name 

Duplicate Wine | 
Duplicate 

 

Vintages Adds a new vintage and copies the properties of the 
selected vintage 

Names Opens the Wine dialog box for editing a selected 
wine name 

Edit Wine | Edit 

 Vintages Opens the Vintage dialog box for editing a selected 
vintage 

* Select Method: The menu item, shortcut key and toolbar icon used to select the command. 
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Appendix B: Additional Commands 
Command Select Methods* Description 

File | New 

<Ctrl + N> 

New 

 

Creates a new collection (file) 

Open HotSync 
Collection 

File | Open Hot-Sync 
Collection 

Opens the collection defined as the HotSync collection 

File | Open 

<Ctrl + O> 

Open 

 

Opens the Open dialog box to load an existing collection 

File | Save 

<Ctrl + S> 

Save 

 

Saves the active collection.  If the file is unnamed, it opens 
the Save As dialog box. 

Save As File | Save As Saves the active collection as a different collection name 
or location 

Import File | Import Opens an Import dialog box 

Export File | Export Open an Export dialog box 

File | Print 

<Ctrl + P> 

Print 

 

Prints a report of the data currently in view 

Print Preview File | Print Preview Previews the report before printing 

Print Setup File | Print Setup Opens the Print Setup dialog box 

Exit File | Exit Closes Wine Master 

Register Options | Register Opens the Registration dialog box 

Hot-Sync Options | Hot-sync Opens the Hot-sync dialog box for installing conduit and 
setting HotSync Collection 

View | Catalog View Catalog 

<Right Click> | View a 
Catalog 

Changes the table to View a Catalog 

View | Name Name View 

<Right Click> | View 
by Name 

Changes table to View by Name 

View | Vintage Vintage View 

<Right Click> | View 
by Vintage 

Changes table to View by Vintage 

View Status 
Bar 

View | Status Bar Shows or hides status bar 

View Toolbar View | Toolbar Shows or hides toolbar 

Categories Wine | Categories… Opens Categories dialog box 
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Command Select Methods* Description 
Collection Wine | Collection Opens Collection dialog box 

Wine | Find… Find 

<Ctrl + F> 

Opens Find dialog box 

Wine | Find Next Find Next 

<Ctrl + G> 

Search for next matching name 

Help Help | Help Topics Opens On-line help 

Help | About Wine 
Master for Windows 

About 

 

Opens Wine Master dialog box 

What’s This 
 

Opens help file description of selected object 

* Select Method:  The menu item, shortcut key and toolbar icon used to select the command. 
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Table Columns 
Appendix C: Table Columns 
View Column Description 

Category The grouping of wines by some common characteristic 

Wine The number of wine names in each category 

Catalog 

Qty The quantity of wine bottles in each category 

Wine The name of a wine 

Category The category of the wine  

Vtg The number of vintages in each name 

Name 

Qty The quantity of wine bottles in each name 

Wine The wine name of the vintage 

Category The category of the vintage 

Vtg The year the grape was picked 

Hold The year the wine is recommended to be held unopened until 

Qty The number of wine bottles in stock 

Price The price of a bottle 

Rating Numeric rating of the vintage 

Bin Location where vintage is stored 

Producer Wine producer 

Region Region where wine was produced 

Vintage 

Notes Remarks about the vintage 

Appendices  31



Chapter 6: Glossary 

Bin: Numbered storage location of a vintage. 
Catalog: A listing of wines by category.  Up to 15 categories can be defined in each wine 

collection.  A sixteenth category, Unfiled, is always present. 
Category: A grouping of wines by some common characteristic.  A category can be any 

alphanumeric text of up to 15 characters.  
Conduit: A software medium used to transfer data between a Palm handheld and a desktop 

computer. 
Document: Wine Master collection file.  The term appears in pop-up hints. 
Export: Copying data to a different file type. 
Handheld: Small computer.  Properly referred to as a Palm handheld. 
Hold: The year, until which a vintage should be held, unopened. 
HotSync: Data synchronization between a desktop computer and a Palm handheld computer. 
Import: Adding data from a file of a different type. 
Name: Wine name. 
Qty: Abbreviation of Quantity, which appears as a column header in the data table. 
Robert Parker: World-renowned wine critic.  He is the author of many books on wines, including The 

Wine Advocate.  To get more information about Robert Parker and his books visit: 
http://www.winetch.com  

Unfiled: A wine category for unspecified wine names.  By default, wines are categorized 
Unfiled.  After importing, wine names whose categories are not found in the catalog are 
categorized Unfiled. 

Vintage: The yield of a wine in a particular vineyard in a single season.   
Vtg: Abbreviation of Vintage, which appears as a column header in the data table. 
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